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Welcome From The Chief Editor
WOW! I can’t believe it’s June already! Our new
family member will be here in just over a couple of
months, and there is so much stuff left to do. At this
point, if days were 48 hours long, I still wouldn’t have
enough time to get all the things done that I want to
be able to get done.

user experience possible. I anticipate that if I were to
try one of the other Linux distros that still supports
32 bit processors (and I have, both before I came to
PCLinuxOS, and after, running them in a virtual
machine), I would become (did become) frustrated
with their lack of polish. It’s that same polish that
Texstar has meticulously applied to PCLinuxOS that
I have become accustomed to seeing and using.

And, since the death bell has tolled for the 32 bit
version of PCLinuxOS, that adds one more thing to
my list of things to do (that I had kept putting off).
Like many Linux users, I find great satisfaction in
taking older, discarded computers and extending
their life by running Linux – namely, PCLinuxOS. I
don’t have to have the fastest, latest, greatest
computer. I’m not a “gamer,” so I don’t even need
“fast” graphics. When it comes to graphics, I’m
perfectly satisfied with being able to stream videos
at a reasonable bitrate (not necessarily the highest
… 360p or 480p is just fine in most cases) with
minimal lag and buffering, or without them breaking
up.
For most “normal” users, upgrading 32 bit versions
of PCLinuxOS probably isn’t as big of a task as it is
for me. I keep and maintain about a dozen
computers running with PCLinuxOS. Of those, half –
six, to be exact – are most likely going to have to be
retired simply because they have 32 bit processors.
My dutiful netbook, running one of the early Intel
Atom processors, is (sadly) among the casualties. I
carry my netbook with me in a backpack that I carry
to work. When things at the hospital are slow, I pull it
out and use it to help pass the time between patient
rounds.
I’m not bemoaning progress. I don’t want to stand in
the way of progress. But it really chafes my sense of
frugality to have to prematurely retire those old
computers that are running perfectly fine and
performing their tasks dutifully and without failure.
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I know. I know. Things evolve. Things change. Time
moves on. At the end of the day, I know that I’m just
going to have to grit my teeth and just go ahead and
retire those older computers. And then I remember
reading about nine months ago about an old
Commodore C64 computer that had dutifully
managed a school’s HVAC system for all these
years would finally be retired. It probably would still
be going strong today, had there been anyone left
around who knew how to run and maintain that very
old, popular in its day computer.

Even my old Android phone – a Motorola Droid –
has been repurposed into a YouTube player for my 2
½ year old son, so he can watch “Bob The Builder,”
“Gumby,” and the rest of his favorite shows.
Frugality. In these times of governments adopting
“austerity” measures, making the best use of what
you already have just makes sense.
Sure, I could run a different Linux distro that still
supports 32 bit processors on those computers. But
I’m not just a Linux user. I’m a PCLinuxOS user. The
loyalty runs deep. With PCLinuxOS, Texstar (and
crew) has created a version of Linux that, in my
humble opinion, is how Linux should be done. It has
been tweaked to a very high level to provide the best

Yes, I’ll get around to updating my computers to the
64 bit version. I know I can’t do it at the end of the
month, since I have to put out the magazine every
month. Plus, with the baby coming, I’m making good
progress on my remodeling project. Babies don’t
wait for anyone; they have their own schedule. Who
knows … maybe I’ll get a sliver of time to start the
update process before the next issue of the
magazine comes out.
Until next month, I bid you peace, happiness,
serenity and prosperity.

DOWNLOAD

Mate Desktop
Page 3

Take PCLinuxOS On Vacation With You
by Paul Arnote (parnote)
Ahhh! Summertime (at least in the Northern
hemisphere). Time for barbeques, swimming pool
parties, camping, bicycling, fishing, going to the
beach, spending time at an amusement park, and
taking family trips. Here in the U.S., most people
take a “vacation” from their job to enjoy these
leisurely activities. In other parts of the world, they
call it “going on holiday.” Whatever you call it, it’s a
time that many people look forward to every year. It
also provides a “reset” from the daily grind that we
endure the rest of the year.
Certainly, you probably aren’t too keen on being “out
of touch” with certain aspects of your life, even when
you’re on vacation. So, take your PCLinuxOS laptop
with you. Many will want to be able to check their
email accounts. Others may want to keep abreast of
the happenings in the PCLinuxOS forum before
turning in at night. Still others will want a way to view
their digital photos from the day, and to transfer them
from SD cards to their computer. Still others may
want to create a travel blog, summarizing their daily
activities at the end of the day.
Although I don’t travel often, I have carted one of my
PCLinuxOS laptops with me every single time. To
make things easier, I tend to pack everything in an
inexpensive laptop backpack, where I can keep all of
my computer accessories together and handy.
Below are some tips for traveling with your
PCLinuxOS laptop.
• Perform updates at least a couple of days
BEFORE you leave on vacation. You can never be
certain what your internet connection will be like at
your destination, and you don’t necessarily want to
spend time at your destination applying updates on
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Take PCLinuxOS On Vacation With You
a slow or unreliable internet connection. Reboot your
computer a couple of times after performing updates
to make sure that everything works as it should. As
careful and as good as the packaging team is,
sometimes a seemingly simple update can break
things that were working perfectly before.
• Be sure your laptop battery is in top shape. If it
isn’t, order a new laptop battery before you leave for
vacation. And, be sure it’s properly charged. In fact,
it might be a good idea to have a couple of batteries
– one in the laptop, and a second one that’s fully
charged and ready to go in the event that your
primary battery runs down.
• Insure that
adapter/charger.

you

have

packed

your AC

• You might want to pick up a car charger for your
laptop, especially if you are driving to your
destination. It will help to insure that your battery(ies)
are always charged and in top shape.
• If you are traveling abroad, be sure that you have
the proper AC power plugs and power adapters for
the area to which you are traveling. For example, the
U.S. uses 120v, 60 Hz power, while Europe tends to
use 220-240v, 50 Hz power. Plus, the plug
configuration is WAY different, and can vary from
country to country. Just take a look at this confusing
list of the different types of plugs that are in use
around the world. The image on the left gives you
some inkling of the confusion that exists.
• Before you embark on your trip is the time to make
sure that you have all of your accessories. I tend to
carry a wireless mouse, a small backup wired
mouse, an external USB SD card reader, a couple of
blank USB flash drives, extra batteries for the
wireless mouse, extra SD cards, along with the AC
adapter(s). With most laptops having a touchpad, it
might seem like overkill to have two mice. However, I
hate touchpads, and I don’t want to have to rely only
on a wireless mouse that might fail (batteries go
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dead, signal interference, etc.) … hence, the small
wired backup mouse. The same situation exists with
SD card readers. Most – but not all – of my laptops
have a built in SD card reader. The external USB SD
card reader insures that I always have a way to read
the SD cards from my digital cameras.
• You’ll also find extra camera supplies in my laptop
backpack, like extra batteries for the camera(s) and
chargers for those batteries (if applicable). There
would be little that sucks more than being present
for some pictures of a lifetime and having dead
batteries in your camera.
• If your destination is one where the availability of a
wifi connection is uncertain, you might want to think
about a wireless 3G or 4G mobile wifi connection.
Be cautious of data caps, however, and of roaming
charges. Both can cripple your connection, as well
as your finances.

• If you’re flying to your destination, DO NOT place
your laptop in your checked luggage. Luggage
handlers at most airports tend to treat luggage rather
roughly, and including your laptop in your checked
luggage is putting your laptop in the expressway
towards certain damage. Instead, make it part of
your carry on luggage, and store it either under the
seat in front of you, or place it in your lap. Never
store your laptop in the overhead luggage storage.
Not only will you increase its chances for damage, it
could also fall out of the overhead luggage area
when other travelers are removing their luggage.
• Exercise caution when connecting your laptop to a
“foreign” (unknown) wifi network. Avoid, if at all
possible, connecting to open, unencrypted public wifi

connections. If you must use an open and
unencrypted public wifi hotspot, keep the time that
you are connected to the bare minimum to get your
task done. Be extra cautious about connecting to
secure sites (like your bank and bank account) over
open, unencrypted public wifi connections. Just don’t
do it. Most hotels and motels I’ve stayed at have
secured wifi connections for their guests. Usually, all
you have to do is ask for the password at the front
desk. Even better yet, sign up for and use a quality
VPN service for enhanced security and anonymity.
Follow these tips, and traveling with your laptop on
your next vacation should be an enjoyable
experience. Oh … and we all can’t wait to see
pictures from your next trip!

Screenshot
Screenshot Showcase
Showcase

• Be sure that you can afford to lose your laptop …
not that you plan to. You probably won’t want to take
your best/most expensive laptop. While there is the
definite risk of having it stolen, chances are higher
that it might end up broken or lost (left on a bus or
taxi, for example). One idea is to buy a second
laptop used, on the cheap, so that if anything
happens to it (caught in a downpour, drop it in a lake
or in the ocean, lost, stolen, etc.), you’re not out all
that much. If you go this route, get PCLinuxOS
installed and all your applications installed a few
weeks before your vacation. This will give you a
chance to tweak and tune the laptop to your
satisfaction. Another advantage is that this second,
cheaper laptop does NOT contain any of your
sensitive data files. Those stay at home, out of reach
of those who’d love to get their hands on them.
• As an added “insurance policy,” take an extra copy
of the latest PCLinuxOS ISO on either a CD, DVD or
USB flash drive. If something bad happens, you can
at least reinstall the operating system and be back
up and running within 20 minutes or less.
Posted by luikki, May 1, 2016, running KDE.
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Inkscape Tutorial: Create Transparent Text
by Meemaw

down <SHIFT> and select the top level text, then
choose Path > Difference. You should now have a
blurred text edge with your third color showing.

I saw another fun text effect that I want to do for you.
In Inkscape, import an image file that you would like
some text in. I’m using a photo from a trip I took to
Utah several years ago. This is Butler Wash, with
Native American rock art. I want to put the text
“Butler Wash” at the top.

Select the top text, and change it to white, then
make a gradient (linear, from above the top of the
text to about the center of the text so the white is
barely visible at the top. Now you should have
transparent text with a bevel, highlight and shadow
sitting on top of your image.

Move the blurred text to the bottom of text stack (but
above the image). Choose the top text and change
the color to white, then do Path > Outset once or
twice. Move it below the text it is above (1 level),
select both and do Path > Difference on them. It will
look like a white outline with your last color showing.
With the white text outline selected, change the
opacity to 30%, and move it down to just above the
black blurred text.
Load your photo, then create your text. Change to
the selection tool, and make the text the size you
want. Now, make 4 copies of it using Edit >
Duplicate or <CTRL> + D. It helps to make them
different colors so you can tell them apart.
Change the top copy to black, change the blur to
0.5, then do Path > Outset two or three times,
depending on how big everything is and whether you
used bold text or regular. Move your black text to the
right just so the next copy is visible, then lower it one
level. Now you should have a different color text
above the black text. With that text selected, hold
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Posted by Crow, May 11, 2016, running KDE.
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PCLinuxOS Recipe Corner

Japanese Beef Tenderloin Curry
Ingredients:
1 1/3 Lbs (600 grams) of beef tenderloin,
cut into chunks
1/2 of red bell pepper, cubed
1 sweet potato, peeled and cut into pieces
2 big onions, sliced
1 japanese curry block
1 tablespoon of oil
3 Cups (700 ml) of water

vegetables, pour in water and add curry block.
3. Bring to boil, then reduce heat and simmer about
20 minutes till potatoes are boiled.
4. Serve on bed of steamed white rice.
5. Sprinkle with coriander. (optional)

Marinade:
1 tablespoon of light soy sauce
1 tablespoon of sake
Directions:
1. Mix marinade, add meat and
refrigerate minimum 1 hour
(could be overnight).
2. Heat oil in the wok and fry
onions, add meat fry till it
changes colour, add remaining
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ms_meme's Nook: Linux Will Keep Us Together
Linux Linux will keep us together

Made by Texstar

Think of me babe whenever

He's always building it up

Some Windows guy comes along

And years from now

Trying to sing my song

Who will be booting it up

Don't mess around tell him so long

I will I will I will

Linux does something to me now

I will be booting Linux forever

From Windows sets me free now

It gets better and better

If it starts hanging around

I've said it before and I say it again

Send it outbound

It's win win win

Use PCLOS it's a merry-go-round

I love Linux it is so clever
Stop download PCLOS
Stop get rid of all the rest

MP3
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Panopticlick: How Secure Is Your Browser?
by Paul Arnote (parnote)
During these times, heightened security of one’s
personal data has remained at or near the forefront
of many users’ concerns. Whether it’s concern over
government collection of that personal data, or
collection of personal data by even more nefarious
entities, keeping your personal data secure is a
huge issue. Even the tracking employed by various
websites can reveal a lot about your interests,
purchases and activities.
But, how secure is that one tool you probably use
the most in your online interactions: your web
browser? You might be surprised by what you find
out. Thanks to a research project by the Electronic
Frontier Foundation (EFF), you can easily determine
just how secure your web browser is from tracking.
Who better to lead the fight for our privacy than the
very organization that is (and has been) at the
forefront of the fight for our privacy. That research
project is called Panopticlick.
The purpose of Panopticlick can best be summed up
with this statement from the EFF:
Panopticlick is a research project designed to better
uncover the tools and techniques of online trackers and
test the efficacy of privacy add-ons.
Panopticlick isn’t exactly new. The EFF started
Panopticlick in 2010 to investigate how unique each
browser is. It gathers anonymous information about
the configuration and version number from your
operating system, your browser, and your plugins. It
then compares your configuration against their
database of other users configurations, creating a
“uniqueness” score. That uniqueness score reveals
how identifiable you might (or might not) be while
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browsing the web. In 2015, the EFF added tracker
blocking testing. This most recent addition gauges
how effective those tracker blocking add ons, such
as AdBlock Plus, Ghostery and others, are in helping
to protect you from overly intrusive data collection.
Upon your visit to the Panopticlick website, simply
click on the “TEST ME” button in the middle of your

browser window. Never fear, as only anonymous
data is collected (and since it’s the EFF, I trust them
when they say that only anonymous data is collected
… their hard fought and earned good reputation is at
stake). It will then analyze how well your browser
and add ons work to protect you from online tracking
techniques and the gathering of private, personal
data.
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Panopticlick: How Secure Is Your Browser?
After churning through a few test screens,
Panopticlick will display a summary of its results.
Since I primarily use Firefox, the results displayed
here are from that particular web browser. With it, I
also use the AdBlock Plus add on. In the past, I’ve
also used the Privacy Badger (from the EFF) and
Ghostery add ons, plus a few other privacy add ons,
but have since disabled them because I’ve found
them to bog my computer down too much, or they
blocked out too much content that I was interested in
accessing. As much as I want to block the gathering
of my web browsing habits and data, it’s also
important to balance it against the web browsing
experience. When the tools make your web
browsing experience suffer, those tools become a
hinderance and stand in your way of getting things
done and having an enjoyable experience.
Clicking on the “Show full results for fingerprinting”
link below the chart will reveal just how much
information is revealed when you visit a website. You
will most likely be as surprised as I was. I won’t
show my detailed results here for two reasons. First,
it’s just too long. Second, your results will be
different since you will most likely have other fonts
installed (yes, fonts play a role in fingerprinting) and
you will most likely have different browser add ons
installed.
Why Panopticlick?
When you visit a website, a tremendous amount of
data about your computer’s configuration is available
and is shared. This information (OS, browser,
versions of both, installed fonts, installed add ons,
etc.) can create a unique “fingerprint,” which can
then be used to identify you and your computer.
A LOT of excitement was generated a few years
back when the major web browsers implemented Do
Not Track. This, if implemented properly, should give
users relief from being tracked across the web.
However, this has not been the case, since honoring
Do Not Track requests is purely voluntary. As a
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result, the list of websites that honor Do Not Track is
rather short. Don’t be disappointed to not find your
favorite website on the list. It most likely isn’t
complying.
When it was first introduced, there was hope that it
would give web users the same level of protection
that the popular Do Not Call list is supposed to give
to U.S. telephone consumers. However, despite
repeated promises from the internet advertising
companies, there has been no progress on the
matter. In fact, progress has been virtually
nonexistent, since standardization of Do Not Track
has become deadlocked in the World Wide Web
Consortium, despite repeated pleas from American
and European policy makers to make it happen.
Then you have websites that could care less about
tracking the visitors to its website, like The
PCLinuxOS Magazine website. If only things could
be that simple.
In November 2015, the United States Federal
Communications Commission (FCC) refused to
make honoring Do Not Track requests compulsory.
The agency was petitioned to require some of the
web’s largest firms – Google, Facebook, Netflix,
Pandora, YouTube, and LinkedIn were given as
examples – to honor user requests to not be
tracked.
Not All Browsers Created Equal
Like many users, I have several web browsers
installed on my computer. So, to satisfy my curiosity,
I loaded up the Panopticlick website in each of them
to see how they performed. The results may surprise
you.
Firefox, Chrome and Slimjet all performed the same,
giving the same results as those displayed above.
They all protected against tracking ads and blocking
invisible trackers, but failed to unblock third parties
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that promised to honor Do Not Track, and failed to
protect against fingerprinting.
Midori and Opera only protected against tracking
ads. They allowed invisible trackers, failed to
unblock third parties that promised to honor Do Not
Track, and failed to protect against fingerprinting.
Probably the best protection you can currently get to
protect yourself against fingerprinting is to use the
Tor browser. Its features go a lot farther in providing
the protection against fingerprinting. The trade off is
that browsing with the Tor browser is significantly
slower than using just about any other browser.
Summary
You have to applaud the EFF’s efforts with their
Panopticlick research project. It is hopeful that, as a
result of their data collection, users can be provided
with information about how to best protect
themselves from tracking, and subsequently protect
their data.

rules, Do Not Track is pretty much useless,
ineffective and dead in the water. Until then, about
the only hope internet users have are organizations
– like the EFF – compiling a database of browsers
and their add ons that provide the highest level of
protection. So, your participation (by submitting data
to the research project) helps the EFF provide the
information that other users will rely on to help
protect their privacy and browsing habits.

Linux Docs
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Donate NOW

Without compulsory rules (technical and/or legal)
about honoring Do Not Track, it’s doubtful that it will
ever fulfill its promise to internet consumers and
users. In fact, without those technical and/or legal
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PCLinuxOS Family Member Spotlight: Besonian
as told in his own words to YouCanToo.

My name is Jeff Grant. As for my age, put it this way
- I can remember the Nazi blitz on London - vaguely.
I was married twice, and have two children from
each of those marriages. I've been for fourteen
years now in a relationship with a lovely lady called
Anita who has two boys of her own from a marriage
in which the boys’ father died over twenty years ago.
The name 'Besonian' which I use on this forum
comes – I think – from Shakespeare's 'Hamlet'. And
if my memory serves me correctly – which it may not
– there is a short exchange in that play between two
soldiers. And one says to the other, “Under which
king, besonian, speak or die!” I believe 'besonian' is
antique Italian for 'rascal', 'rogue'. And why it always
stuck in my mind, I've no idea. But it did.
I live in an area of South London called Crystal
Palace. Those who follow English Premier League
soccer might be aware of our local team who are in
the top half of the Premier League table. London
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generally has a lot of open spaces - parks etc. - but
Crystal Palace has more than most. The largest of
these by far are the grounds of what was once the
actual Crystal Palace - a vast Victorian building
composed of eleven million panes of glass and
which housed the world's first international and
permanent trade fair. It famously burned down in
November 1936 and created such an inferno that
every fire appliance across London was called to try
to put it out. But it burned to the ground leaving only
a tiny fraction of the actual structure standing. The
park now contains, among other things, the UK's
National Sports Centre, a maze, an open-air concert
area by a lake, and another lake surrounded by lifesize statues of dinosaurs (!) created in the
nineteenth century.
I've lived here now for over ten years. I was born in
Leicester, a city of some 330,000 people situated
about a hundred miles north of London. But since
my early teens I've always lived either in London or
in the area immediately around it. I went to school at
a small town called Egham just outside London, very
close to the island in the River Thames where
Magna Carta was signed, and subsequently took a
degree in English Language and Literature at St
Edmund Hall in Oxford University.
The urban part of the Crystal Palace area is centred
around three roads known as The Triangle. It has an
intimate, 'villagey' atmosphere. If you live here you
soon get to know all the shopkeepers, most of whom
own their own small outlet. The area is home to one
of the most plentiful and varied collections of
restaurants in the capital - Indian, Chinese, Thai,
Brazilian, Venezuelan, Portuguese, Sardinian, North
African, Colombian etc., etc. It’s but a five minute
walk - through another small park - from my flat
(apartment) to all this food!

My partner Anita has her own flat just a mile away
from mine. We live and work separately during the
week but spend every weekend together and often
days in between. Between us we have six children –
hardly 'children' any more. In descending order of
age - the eldest, my Jackie lives in central France
with her partner and my three grandchildren; my
next one - Mark - is a Unix/Linux expert (he's worked
with Unix since the early nineties) running the IT
department in a Norwegian shipping company; the
next one down - Alastair - teaches English in Buenos
Aires; next is Sam who lives about five miles away
from me in London, studying music at the School of
African and Oriental Studies; next is Anita's Joe who
is living at the moment in Ukraine; and lastly the
youngest, her Ben who works in North London
writing computer code and has a Masters Degree in
philosophy at Oxford.
Technically I'm retired - by which I mean that the job
I did for thirty years I now no longer do. But I do
another - I write. After leaving Oxford I worked first in
advertising and then in the film industry. In
advertising I was a producer of TV and cinema
commercials in three big London agencies. I did that
for six years until I was offered a trial as a director by
one of the film companies I worked with. For a
number of years thereafter I directed cinema and TV
commercials and Public Information Films. One of
the latter, more years after its birth than I care to
remember, is still garnering comments on YouTube
(https://www.youtube.com/watch?v=XNPMYRlvySY
- then click on ‘The Spirit of Dark and Lonely Water)
as the scariest Public Information Film to be
transmitted on UK television - even tempting people
on the net to make weird variations of it. From
commercials I moved on to making longer films mostly sponsored documentaries and corporate
films for people such the Ford Motor Company, the
Rank Organisation, the BBC, Central Television etc.
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Apart from South America, I worked on every
continent – and especially in the US.
But now, I write. And in fact, only a few weeks ago I
published a novel - 'Albatross - the scent of
honeysuckle'
on
Amazon.
(http://www.amazon.co.uk/Albatross-scenthoneysuckle-JeffGrant/dp/0993332803/ref=sr_1_44?s=books&ie=UT
F8&qid=1444485269&sr=1-44&keywords=albatross)
And I'm already working on my next which has been
gestating for about twenty years!
Neither Anita nor I have any pets. I love dogs and
we'd both love a cat. But with both of us living in flats
on the 6th floor of apartment blocks, it seems unfair
to coop up an animal with no real hope - short of
falling out a window - of ever getting a breath of
fresh air. In addition to our London flats we have a
house in central France only half an hour drive from
La Souterraine, the town in which my daughter
Jackie lives. We try and get out there for extended
periods twice a year. We have a medium-size
camper-van and these days always drive there. We
get the cross-Channel ferry from Newhaven to
Dieppe in northern France - a four hour crossing, the
English Channel (or ‘La Manche’ if you’re French!) at
that point being much wider than the famous DoverCalais stretch. There's a unique freedom with a
camper-van - you take your home with you wherever
you go. On our drive down to our French house we
stop where we fancy, make ourselves a meal, take a
break and look around - the journey has become
part of the holiday. The camper-van has also made
possible many great holidays in various parts of the
UK.
I do a lot of photography. I've done so since I was in
my teens. I work exclusively now with a Nikon digital
camera and lenses. Having spent all my working life
using film, It took me a long time to be convinced
that digital was as good and as versatile. I believe
now that it is. But many feature films are still shot on
celluloid, and indeed it may still have an edge in
versatility. I've many thousands of photographs, and
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have in the back of my mind – the only place where
there's room for it – an idea of having a local
exhibition one day.
Another interest is bird-watching. In the UK it's a
popular pastime for thousands. I'm not what they call
'a twitcher' - i.e. one who speeds off all over the
country as soon as the news of some rare bird
blown off-course by Atlantic gales is posted on social
media, simply in order to see it and tick if off in
his/her notebook. I'll sit in the garden in France for
example, and simply watch the avian comings and
goings - in one three week period last year I noted
almost thirty different species either in our garden or
overflying it.
I also play piano. If I could devote the necessary
time to it, I'd be pretty good - though I say it myself.
But writing's my first creative love – I've been doing it
since the age of seven! - so that's how the vast
majority of my time is spent.

an ISO of PCLinuxOS and put that in the computer.
Everything just worked! I was amazed and delighted.
I played around with it for a long time, then set up a
dual-boot situation with WinXP. Within six months I'd
abandoned XP and was using PCLOS for all my
work. And so it has stayed. I've never again had a
need to use Windows. So my enduring thanks are
due, especially to Tex - and to those other command
line whizzkids who have helped me and so many
others on the forum in times of trouble and
confusion.
Finally - about four years ago I started a blog. For a
long time I hadn’t added to. But only last week I
started it up again, one of the main reasons being to
create some publicity for my book. If anybody
among this illustrious band of PCLOS brothers and
sisters is interested, here’s the link https://besonian.wordpress.com/
Maybe see one or two of you there sometime.

Linux - my first introduction to it was via my eldest
son Mark, in the early 'nineties. He was working at a
software company in London and was using this
strange thing called 'Unix'. In his spare time he was
tinkering with this other strange thing called 'Linux'.
What he showed me intrigued me. I could see then
its potential, but it seemed that until it was at least as
easy to install as Windows – and installing it was a
bit of a nightmare - there was no way it was going to
make any serious inroads into Microsoft's empire.
We all know how different the situation is today.
Writing scripts for my work, I used the various
versions of Windows as they came out. But it was
not only the pain of dealing with constant malware,
updates and having to search for drivers that
bugged me, but what I saw as the often dodgy way
Microsoft did its business. So I kept an eye on Linux
through the years, trying various distros from time to
time. None of them, for all sorts of reasons did it for
me - they'd be difficult to install, or once installed
things didn't quite work as they should or there'd be
no driver for this or that. Until, that is, I burned to CD

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.
If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.
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Posted by Fanofscifi, May 19, 2016, running Mate.
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Tip Top Tips: Making A Clickable
Thumbnail Image With bbcode
Editor’s Note: Tip Top Tips is a new monthly column in
The PCLinuxOS Magazine. Each month, we will feature –
and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept
independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a
tip, share it in the PCLinuxOS forum’s “Tips & Tricks”
section. Your tip just may be selected for publication in
The PCLinuxOS Magazine.
This month’s tip comes from PCLinuxOS forum
member YouCanToo.
To make a clickable thumbnail image in the forum
we need to use two common tags. Those are the
[url] [/url]

[img] [/img]

tags. So let’s get started. I uploaded the image I
wanted to the myphotos.mypclinuxos website. I then
used the supplied the bbcode for my image
[img]http://myphotos.mypclinuxos.com/images
/youcantoo/trinitydesktop2.png[/img]

To this code, I added the following to the img part of
the code: width=350
[img
width=350]http://myphotos.mypclinuxos.com/
images/youcantoo/trinitydesktop2.png[/img]

This will resize the image to a width of 350 pixels
while maintaining the ratio of the height.

Now, go ahead and click on the image in the forum.
It should display the original image of 1024x576
pixels.
Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!
Here's where the url tag comes into play. Add the url
tag before the img tag. It should look something like
this. You will notice that the url tag contains the
same information as that which is contained in the
img tag. That is the actual url to the image.
[url=http://myphotos.mypclinuxos.com/images
/youcantoo/trinitydesktop2.png][img
width=350]http://myphotos.mypclinuxos.com/i
mages/youcantoo/trinitydesktop2.png[/img][/
url]

This now produces a clickable scaled image that
looks like this:

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?
Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

The image will now look like this (top of next column)
when displayed, but at this point the image is still not
clickable.
Download your copy today! FREE!
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Game Zone: The West
by daiashi

System requirements:

Some Gameplay Screenshots

Fully updated PCLinuxOS
Hardware:
Minimum:
OS: PCLinuxOS and Chrome browser.
About The Company
About The Game
InnoGames' online role-playing game The West
sees you start as a greenhorn facing the dangers of
the Wild West. Create your own avatar and collect
experience by completing tasks and doing jobs.
Become a gunslinger by challenging other players to
duels. Prove your skills in adventures, or just storm
forts.
Follow the tracks of Jesse James and Billy The Kid:
explore the Wild West, fight duels with other online
players, conquer forts and experience exciting
adventures. The West is a cowboy browser-based
role playing game. You have individual character
development in that you can choose what skills and
such your character has as you gain points.
Compete with your friends in duels, achievements
and crafting. You start out creating your character,
and then it’s off to the tutorial. After that, the training
wheels are removed and you’re off.
I was once involved in playing another browserbased game, Tides Of Fortune. I somewhat knew my
way around this title, but The West is much more
enjoyable and immersive.
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InnoGames is one of the worldwide leading
developers and publishers of online games.
The company hit 100 million Euros revenue in 2015
and has over 150 million registered players from all
over the world.
More than 400 people from over 30 countries are
currently working in the offices in Hamburg and
Dusseldorf. Brothers Eike and Hendrik Klindworth
start developing the browser game Tribal Wars with
Michael Zillmer. The team is motivated by the idea of
creating a game they would enjoy playing which
would also offer an extensive, fun gaming
experience.
What was originally intended to be a hobby project
has grown much quicker than expected. After Tribal
Wars was officially launched in June 2003, the
number of players increased to several thousand by
early 2004, which made the introduction of a second
world necessary.
Due to the increased popularity of Tribal Wars, the
three company founders decided to work full-time on
the development and operation of browser games.
InnoGames was founded in early 2007 to handle the
operation and continued development of its games.
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Game Zone: The West
Linux Training
Courses & Classes

Screenshot
Screenshot Showcase
Showcase

Getting It To Run
Open your Chrome browser/Web Store/Games.
Search for The West, and add it to Chrome. It’s that
simple. It will ask you for your Google login. I did so
but did not accept anything else. Creating my
account on the page took me to the game, and I was
up and running.

Visit.
Contribute.
Build.
The PCLinuxOS
Knowledge Base
It Belongs To YOU!
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Posted by trytip, May 4, 2016, running KDE.
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Inkscape Tutorial: Creating An Interactive Object
by Khadis
It’s not a new thing that the interactivity function will
make designing more fun, but it is available in
Inkscape. There are so many things that we can do
there, BUT, it will need some JavaScript tricks.

Create text fields labeled “Secret #1”, “Secret #2”,
and “Secret #3” and put them above the 3 previous
white rectangles. The temporary look might be like
this:

For “page 3” (saved as “interactive-3.svg”), I created
this:

In this article, I will show you the basic and simple
steps about how to make an interactive object. My
example is not very cool stuff, but at least, it will
inspire you to make more creative contents. And, it
might be useful to create contents for your
blog/website, or to create a unique presentation.
Let’s check it out!
As usual, start your Inkscape. Then create a
rectangle at any size and color you’d like. I used 15
x 8 cm rectangle and colored it with red.
Insert the text “Tell me a secret!” with any font you
like. I used white Arial Black 36pt. Put the text
horizontally center to the red main rectangle. Then,
create 3 new white rectangles and arrange them as
shown in the illustration below:

And for “page 4” (saved as “interactive-4.svg”), I
created this:
Now, group the “Secret #1” text with the rectangle
below it. Do the same step with “Secret #2” and
“Secret #3”. Later, let's call this set as “page 1.”
Save your work as “interactive-1.svg.”
Create other sets of pages. For “page 2” (saved as
“interactive-2.svg”), I created this:

Now, go back to the interactive-1.svg page. Select
the “Secret #1” group, right click, and choose Object
Properties. Find the Interactivity option, and in the
onclick
column,
type
this
code:
window.location='interactive-2.svg'. (see next page,
top left)
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Inkscape Tutorial: Creating An Interactive Object
linuxfordummies.org
There Are No Stupid Questions

Screenshot
Screenshot Showcase
Showcase
Select “Secret #2” group, right click again, and
choose Object Properties. Fill with this code:
window.location='interactive-3.svg' in the onclick
column under Interactivity option.
Do the same action for “Secret #3” group by filling
code: window.location='interactive-4.svg' in the
column onclick.
To make every “secret” group (or now, it becomes a
button) in every page is clickable, make sure to put
the code in every button on every page.
Now, let's test our creation.
Close all Inkscape windows. Then, right click
interactive-1.svg, and open with your browser
(Firefox or Chrome).
There, you can try to click “Secret #1”, Secret #2”,
and so on. Once you click the button, it should jump
you to “Secret #1” page, “Secret #2” page, and so
on.
Later, you can add a Back or Home button to jump
you back to the main page.
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Posted by daniel, May 2, 2016, running LXDE.
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PCLinuxOS Recipe Corner (Bonus)
Smoke for 20 minutes (by this point the packet will
stop emitting smoke).
Remove smoked watermelon from barbeque and cut
rind off; cut flesh into ¾ inch (2 cm) cubes.
Gently place cubes in a colander and let drain for 10
minutes.

Smoked Watermelon Salad
Ingredients
½ seedless watermelon
1 cup (250 mL) wood chips for smoking
1/4 cup (60 mL) extra virgin olive oil
2 limes, juiced
1 teaspoon (5 mL) sea salt (use smoked salt if you
have it)
½ teaspoon (2.5 mL) freshly ground black pepper
½ cup (125 mL) fresh mint leaves, chopped
1 cup (250 mL) crumbled feta cheese

Soak wood chips in water for 30 minutes.
While chips are soaking, cut watermelon
lengthwise into two pieces and then cut these
segments in half. You’ll now have four large
pieces of melon. This gives more surface
area to absorb the smoke.
Drain wood chips and place on a sheet of
heavy duty tin foil; fold up edges to make a
packet. Pierce holes all over the top of the
packet. Place directly on top of burner of gas
barbeque and preheat barbeque to very hot.
soon

Place watermelon, rind side down, directly on grill,
as far away from the packet of smoking wood chips
as possible (over one of the burners that has been
turned off).

To assemble salad, place drained,
watermelon cubes in a serving bowl.

chilled

Make vinaigrette by combining lime juice, olive oil,
salt and pepper in a small jar with a tight lid and
shake well until blended (this can be done ahead of
time).
Drizzle the watermelon with the vinaigrette
and toss gently to combine.

Method

As

(depending upon your grill, this could take up to 30
minutes), reduce heat in barbeque to medium (or, if
possible, leave burner under packet on high and turn
off other burners).

Refrigerate until ready to assemble salad, no more
than one hour before serving. Note that you can
smoke the watermelon up to 24 hours prior to
serving, as long as you have the means to
refrigerate it afterwards.

as

packet

begins
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to

smoke

Sprinkle the chopped mint leaves over the
watermelon and toss gently once again.
Sprinkle crumbled feta over the top and
serve, using a slotted spoon.
Makes 6 – 8 servings.

The PCLinuxOS
Magazine
Created with
Scribus
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Screenshot
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The place where breaking news,
BitTorrent and copyright collide

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Posted by ruel24, May 24, 2016, running KDE.
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SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.
When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.
Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.
Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same.
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the
English
language.
Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:
0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z
6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

Download Puzzle Solutions Here
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Possible score 280, average score 196.
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PCLinuxOS Crossword Puzzle: June 2016
Vacations

1. have someone else showing you around
2. an extra object to take home
3. your list of activities
4. mail several to your friends at home
5. take lots to remember all the fun
6. wear it in the pool
7. place & time you are leaving
8. vacation spot surrounded by water
9. have fun riding the rides
10. a beautiful feature of a river
11. many places to see works of art or
scientific displays
12. playing in the sand!
13. to make sure there’s a plane seat or
hotel room
14. where you are headed
15. to take movies of your trip

Download Puzzle Solutions Here
PCLinuxOS Magazine
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PCLinuxOS Puzzled Partitions

Vacations Word Find
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airport
amusement park
automobile
bathing suit
beach
binoculars
camera
campground
cruise ship
departure
destination
excursion
garment bag
guided tour
highway
holiday
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video camera
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Connect

Disclaimer

All your
PCLinuxOS
connections in one
convenient location!

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...

1.

All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2.

The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3.

The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5.

Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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Posted by Hertz, May 1, 2016, running LXDE.

Posted by tuxlink, May 1, 2016, running KDE.

Posted by OnlyHuman, May 17, 2016, running e20.

Posted by zerocool, May 12, 2016, running KDE.
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